
Sniffer Dog™

for Apple® Macintosh® Computers

Neptune Systems
12819 Staton Drive

Austin, Texas 78727-3249
(512) 837-1247

Copyright© 1995  Neptune Systems.
All Rights Reserved.



NOTICES 

Trademarks

Sniffer Dog™ is a trademark of Neptune Systems. All other brands or product names are 
trademarks or registered trademarks of their respective holders.

Copyrights

The Sniffer Dog™ software and manual are Copyright © 1995 Neptune Systems. All 
rights reserved. No part of this manual may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, electronic, mechanical, photocopying, or
otherwise, without prior written permission of Neptune Systems.
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W elcome to Sniffer Dog™. This chapter is intended to get you up and running quickly 
using the sample test file supplied with this software.

Installation

Insert Sniffer Dog™ disk 1 into the 3.5 inch disk drive. The disk window appears as 
shown in Figure 1. To install Sniffer Dog™, double-click on the Sniffer Dog™ Installer 
icon.

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 1

If you wish to install the software on an external hard disk, you can change drives by 
clicking Switch Disk.

Next, click the Install button to proceed with the installation.
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After the successful completion of the installation, a new folder named Sniffer Dog™ 
Folder will appear in the main directory of the chosen install volume.

It is not necessary to restart your computer after the installation. Open the Sniffer Dog™ 
Folder  to view the newly installed files.

Creating your own test file using the Teacher Utility

To create your own test file, double-click on the Teacher Utility icon.

Enter your name (the teacher’s name) and press return. Select New from the file menu to 
create a new test file. The test edit dialog will automatically appear when creating a new 
test file. To enter a new question, select Insert.

Next, select the question type you want to add to the test file. When you finish entering 
your question and answers, exit the edit mode by selecting Exit. Close the test file and 
exit the utility.

If you want the Sniffer Dog™ game to use this new test file, drag and drop the file into 
the Sniffer Dog™ Folder  and rename the test file Sniffer Data . The Sniffer Dog™  
application searches for a file by this name (Sniffer Data ) and uses it’s content the next 
time the application is run. Be careful not to replace any old Sniffer Data files you want 
to save for a later test session.

5



Playing Sniffer Dog™

To run Sniffer Dog™, double-click on the Sniffer Dog™  icon. If your monitor is not in 
256 color mode, you will be prompted to switch modes. The first time you run Sniffer 
Dog™, you will also be prompted to select a screen size. If you are running on a slower 
machine, (IIsi, LC, IIci, IIx), you may want to choose the smaller screen size of 512 x 
322. This will improve the refresh rate of the game.

Keyboard Commands:

To turn left Left arrow or J
To turn right Right arrow or L
To move forward Up arrow or I
To move backward Down arrow or M
Sniff (Investigate) S
Help H
Toggle Grid and Compass G

Mouse Commands:

To select mouse control for movement, choose Controls-->Mouse in the Preferences 
menu. To move forward, position the mouse above the center point of the game window. 
To move backward, position the mouse below the center point of the game window. To 
move left or right, position the mouse to the left or right of the center point of the game 
window. The point on the compass which points directly up is your current direction.

Click on the SNIFF  button or press S when you have arrived at a clue you wish to 
investigate.

Click on the HELP  button or press H when you get lost and need help finding your next 
clue.
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Introduction

Sniffer Dog™ is intended to be used as an educational testing and learning tool. The 
Teacher Utility provides a way for educators to create their own test files. These test files 
are used by the Sniffer Dog™ application to help the student learn the subject matter, and 
also to help the help evaluate the student’s current knowledge of that subject. Sniffer 
Dog™ does not contain any hard coded subject matter. Compass and map skills are 
learned by the student as a byproduct of the exploration of Sniffer’s virtual world.

The subject matter is up to the teacher to freely choose. Create and maintain a database of 
test files for your students unique and educational interactive experience.

You may customize Sniffer Dog™ for your students needs by using the Teacher Utility. 
For example, you may limit your students’ playing time. 

Network support allows you to keep track of the testing progress over a local network.
You may send messages to individual students or all students as a group. You may 
terminate games and check a student’s progress from any networked Macintosh running 
the Teacher Utility.

From the Student’s Perspective

Safe-cracker Sam escaped from prison and is trying to recover his stolen cash. You 
(Sniffer Dog) have been assigned to capture Sam and recover the money. To do this, you 
must find the clues Sam left behind and answer his questions. The more questions you 
answer correctly, the better your chances of capturing Sam and recovering the money.
Refer to Chapter 4 for instructions on how to investigate clues once you find them.

When a question is answered correctly, the game informs the student of the grid area and 
the object the next clue is near. An incorrect answer provides the student the general 
direction of the next clue, but will not tell the student what object it is near. The student 
with the highest number of correct answers will usually finish first. The clues will 
eventually lead to the stolen money. Not all students will find the money. A grade of less 
than 80% will result in the student finding the location of the stolen money, but Sam the 
Safe-cracker will have already beaten you to the cash. A grade between 80 to 99% will 
result in the student finding the money, but not Sam. With a grade of 100% you will 
capture Sam and find the loot. Each test is individually evaluated based upon how many 
questions were correctly answered by the student.

System Requirements

To use Sniffer Dog™, you must have at least a 68020 processor based Macintosh with a 
minimum of 4 megabytes of main memory, System 7.0 or later, and a 512 x 384 
resolution monitor.
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Sniffer Dog™ also requires 256 colors/shades of gray. It will not run in any other 
monitor configuration. It is recommended you have 8 megabytes of main memory if 
running System 7.5 or later, or when using large test files in combination with the Power 
Macintosh version of Sniffer Dog™.
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Considering your Preferences Choices

To get the best refresh rate when playing Sniffer Dog™ avoid using virtual memory, 
RAM “expansion” programs, and screen savers. Also, avoid running other programs 
simultaneously with Sniffer Dog™. Make sure all desk accessories and Control Panels 
are closed. Otherwise, you may notice a slower, “choppier” refresh rate. The smaller the 
screen, the less detail, the faster the game plays.

There are many customizations available to improve the performance of Sniffer Dog™. 
To configure the preferences, choose Preferences from the Sniffer Dog™ edit menu 
before starting a new game.

Depending on the speed of your computer, you may want to turn off the background 
sound or the grid detail. These effects enhance the gaming experience, but they may 
make gameplay too slow on some older machines. Owners of slower machines will more 
than likely need to run with these two options disabled. You may also want to consider 
turning off thunderstorms and increasing you turning and travel speed to their maximum 
values.
On fast machines (PowerMacs, 68040 equipped Macintoshes), you may want to consider 
reducing your turning and travel speed and switching all available preferences on. This 
will make the game more playable and allow you to move through doors more 
effectively.
When you get near an object, the game will automatically slow you down so you can 
effectively manipulate around the object. To turn this automatic slow-down option off for 
trees, choose the Automatic sub-menu from the Preferences menu and uncheck Slow 
Down Near Trees.

Try custom configuring all preferences to yield the performance you desire.

Note: If you change the screen size during the game, the change will not take affect until 
you restart the game.

Configuring Memory Settings

Although Sniffer Dog™ was designed to run on a system with as little as 2400K of 
available memory, under typical conditions, Sniffer Dog™ will require more memory.
The screen size, amount of test questions, and size of test questions all play an important 
part in determining how much memory Sniffer Dog™ needs.

Providing more than the minimum 2500K will allow you to use larger test files and full 
size windows for gameplay.

If Sniffer Dog™ needs more memory, it will display a dialog box when run describing 
the low memory condition and telling you how much extra memory it needs. The 
preferred memory size for the Sniffer Dog™ application can be set by selecting the paw 
icon, and choosing Get Info from the File menu of the Finder. 
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Select the old Preferred size setting, add the amount Sniffer Dog™ needs to the old 
amount, and type it in.
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Figure 3

Summary of your System Level options to speed-up Sniffer Dog™

To get the maximum performance from this product, follow these simple suggestions 
when using any graphics and sound intensive application.

U s e  W o rd  6 .0 c  o r  l a te r  to            

v ie w  M a c in to s h  p ic tu re .              

Make sure all Control Panels, Desk Accessories, and other applications are 
closed before running the Sniffer Dog™ application.

U s e  W o rd  6 .0 c  o r  l a te r  to            

v ie w  M a c in to s h  p ic tu re .              

Temporarily disable any screen savers that may be installed in your Control 
Panels or Extensions folder.

U s e  W o rd  6 .0 c  o r  l a te r  to            

v ie w  M a c in to s h  p ic tu re .              

Disable Virtual Memory (if you don’t need it) by using the Memory 
control panel.
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The Teacher Utility provides a parent or educator with the ability to create and manage 
multiple test files. These test files can be used by the Sniffer Dog™ application to test a 
student on any subject the educator desires. Tests are limited to a maximum of 100 
questions.

Question Types

Each test question created must be in one of the four basic question formats listed below.

U s e  W o rd  6 .0 c  o r  l a te r  to            

v ie w  M a c in to s h  p ic tu re .              

True / False
U s e  W o rd  6 .0 c  o r  l a te r  to            

v ie w  M a c in to s h  p ic tu re .              

Multiple Choice (3 answers)
U s e  W o rd  6 .0 c  o r  l a te r  to            

v ie w  M a c in to s h  p ic tu re .              

Multiple Choice (4 answers)
U s e  W o rd  6 .0 c  o r  l a te r  to            

v ie w  M a c in to s h  p ic tu re .              

Reading Comprehension

Choose one of these formats for each question you intend to add to your test file. 
Although reading comprehension questions consists of a reading paragraph followed by a 
question, the reading comprehension question is counted as a single question, and caution 
must be taken when editing or deleting the follow-up question.

Creating a New Test File

To create a new test file, select New using the file menu.

Enter in the name of the new file and click Save. The test edit window will automatically 
appear after creating a new test file.

To open a test file that already exists, choose Open using the file menu and select the file 
to open (Figure 4). 

You can also open any test file by double clicking on it. The Teacher Utility will 
automatically start and load the selected test file.

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 4
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Adding & Inserting Questions

To add or insert a new question, select Insert  (Figure 5).

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 5

Next, select the question type you want to add to the test file by choosing one of the four 
basic question types discussed (Figure 6). After clicking on the question type, a new 
window appears (Figure 7).

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 6

This window is called the question data window.

Enter the question text into the various fields of the question data window. Full editing is 
supported, so you may want to copy your questions from a previously written document 
and paste them into the question data window fields.

Use Word 6.0c or later to           

view Macintosh picture.             
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Figure 7
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Selecting the correct answer

When you finish entering your question and answers, select the correct answer by 
clicking on the checkbox labeled True, False, A, B, C, D, etc.. The Teacher Utility will 
not let you exit the question data window until you have checked an answer (Figure 7).

If you want to add additional help information for the student, enter the information in the 
help information window which appears next. It is not required that you supply the 
student with any help information (Figure 8).

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 8

Exiting the Question Edit Mode

After you finish entering the question and optional help data, you will return to the test 
edit window. If you want to add more questions, follow the same process previously 
described. When you finish, you can exit the question editing mode by clicking Exit.

Setting the Game Time Limit

In addition to question data, you must supply a time limit for each test file. This time 
limit determines how long the game will run when using this test. The game will 
automatically end when the time limit is reached. Several warnings are issued to the 
student exactly five minutes, and one minute prior to the expiration of the game.

To set this time limit, choose Set Test Time Limit by using the Options menu. Next, select 
the maximum amount of time you want the student to spend on the test. This value is now 
part of the test file (Figure 11).

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 9
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Using Test Files in the Game

Now you are ready to close the test file and use it in the Sniffer Dog™ game. Select 
Close from the file menu, or quit the utility by choosing Quit.

To use any test file in the Sniffer Dog™ game, rename the test file to Sniffer Data and 
place it in the Sniffer Dog™ Folder. The Sniffer Dog™ game will use this test file the 
next time a new game is played.

Viewing Test Results

Every Sniffer Dog™ game which ends normally is recorded in the Sniffer Data test file.

To view tests taken on a particular test file, open the file using the Teacher Utility and 
choose View Test Results using the Options menu.

The Teacher Utility automatically goes through all tests which were taken using that file. 
If you wish to print individual test results at this time, click Print (Figure 10).

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 10

Clearing Test Results

To clear out old tests, choose Clear Tests after opening the test file. Tests are recorded in 
the current Sniffer Data test file in sequential order. After clearing out the old tests 
results, new test results will be recorded into the Sniffer Data test file beginning with the 
next game played.

Printing Options

The Teacher Utility supports printing student test results, testing status, and tests. When 
you print a test, it prints out as a standard classroom test containing all of the test 
questions entered, and the test header. To print a test, choose Print or Print Sorted using 
the File menu. Choosing Print will print a test with the questions ordered the way you 
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originally entered them. Choosing Print Sorted will print a test with the questions sorted 
into sections. The sections are grouped as True/False, Multiple Choice, and Reading 
Comprehension.
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Specifying the Test Header

To include a test header at the beginning of your test printout, choose Print Setup using 
the File menu.

Next, enter your test header information into the test header fields making sure to limit 
the length of your text to the fields provided (Figure 11).

Then, click Exit to exit the window. When you print your test, this information will be 
included at the beginning of the first page.

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 11

Network Options

If you are running several Sniffer Dog™ games in combination with the Teacher Utility 
on a local area network configuration, you may want to consider using some of the 
available network options. All network options are accessed using the Network menu.

To instruct the Teacher Utility to monitor the network, check Network Testing Enabled 
using the Preferences sub-menu located within the Edit menu (Figure 12).

After checking this option, the Teacher Utility will scan the local network for any Sniffer 
Dog™ game players currently playing on the network. Each player located on the 
network will receive a message that indicates you (the teacher) are now supervising the 
players.
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Use Word 6.0c or later to           

view Macintosh picture.             

Figure 12

After locating students playing Sniffer Dog™ on the network, you can use the Teacher 
Utility to send messages, terminate games, or check statistics.

To access these functions, choose the option using the Network menu and 
follow the directions given (Figure 13).

A maximum of 50 students plus the Teacher Utility are allowed on the network at any 
one time.

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 13

The Teacher Utility will be notified when a student finishes his/her game, or 
prematurely exits the Sniffer Dog™ application. When this happens, the test results will 
be recorded in the Sniffer Data  file on the student’s computer.

The Display Test Progress function allows you to monitor the number of 
questions answered, the amount of time left, the number of helps used, and the current 
score of each student (Figure 14).

To view the student’s final score, you must copy the Sniffer Data file to your computer 
and open it with the Teacher Utility, or, use the Teacher Utility on the student’s computer 
to open and view the test results contained in the Sniffer Data file. The final test results 
are not transmitted over the network, and are not accessible by the Teacher Utility 
through the network.
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Use Word 6.0c or later to           

view Macintosh picture.             

Figure 14

Note: Multiple installations of the same Sniffer Dog™ disk not purchased under a site 
license agreement will not run in conjunction with each other over a local area 
Macintosh network. You must either purchase multiple copies of the single user 
version of Sniffer Dog™, or buy a site license copy. The site license version will 
function properly on a network after multiple installations.
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Other Preferences

The Teacher Utility asks you to enter your name the first time it is run following the 
initial installation. If you wish to change this name, select Change Teacher’s Name using 
the Preferences sub-menu located within the Edit menu. This name is transmitted to each 
student after the Teacher Utility is run when using the network based options.

Playing Sniffer Dog™

To run Sniffer Dog™, double-click on the Sniffer Dog™  icon. If your monitor is not in 
256 color mode, you will be prompted to switch modes. The first time you run Sniffer 
Dog™, you will also be prompted to select a screen size. If you are running on a slower 
machine, (IIsi, LC, IIci, IIx), you may want to choose the smaller screen size of 512 x 
322. This will greatly improve the refresh rate of the game.

Keyboard Commands:

To turn left Left arrow or J
To turn right Right arrow or L
To move forward Up arrow or I
To move backward Down arrow or M
Sniff (Investigate) S
Help H
Toggle grid and compass G

To select mouse control for movement, choose Controls-->Mouse in the Preferences 
menu. To move forward, position the mouse above the center point of the game window. 
To move backward, position the mouse below the center point of the game window. To 
move left or right, position the mouse to the left or right of the center point of the game 
window. The point on the compass which points directly up is your current direction. In 
Figure 15, Sniffer is pointing north.

Use Word 6.0c or later to           

view Macintosh picture.             
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Figure 15

Click on the SNIFF  button or press S when you have arrived at a clue you wish to 
investigate.

Click on the HELP  button or press H when you get lost and need help finding your next 
clue (Figure 16).

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 16

Looking for Clues

As described in the overview section, the object of the game is to find Sam the Safe-
cracker and the stolen money.

To find Sam, follow the clues given by the game and proceed to the next grid area to find 
your clue. Every clue is associated with a visual object. Some clues are inside houses and 
buildings and can only be seen after entering the structure. To enter a house or building, 
you must go through the door. If you don’t see a clue inside a structure, you are probably 
near the wrong object. By continuing to search and using your help, you will eventually 
find your clue. You can also follow Sam when you see him.  He will eventually lead you 
to the next clue.

After you see the clue (Sam’s shoe print), travel directly over it and press S or click the 
SNIFF button. Sniffer’s panting will tell you when you are directly over the clue.

Answering the Questions

After sniffing a clue, a new question will appear on the screen. To receive additional 
information or hints as to the correct answer, click on the HELP button. Choose your 
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answer by clicking on the letter that corresponds to the answer text  or by pressing T, F, 
A, B, C, or D.

If you are unsure about the answer, you can come back to the question later by selecting 
Try Later. If you choose Try Later, the question will get moved to the end of the question 
list and will re-appear towards the end of the game.

Use Word 6.0c or later to           

view Macintosh picture.             

Figure 17

All questions must be answered in order to find the stolen money’s location. If you 
choose to not answer a question, the question will be counted as incorrect and you will be 
allowed to proceed to your next clue. A correct answer yields a hint which points you to 
your next clue’s grid zone and tells you what object the clue is near. An incorrect answer 
will only tell you the general direction of your next clue.

After answering all of the questions, you will find the stolen money’s location. If your 
time expires before answering all of the questions, your current status at the time the 
game ended will be recorded in the Sniffer Data file.

Preferences

Sniffer Dog™ has many preferences which allow you to change the way the game looks 
and plays. Many of these preferences deal with graphics detail and sound. The rule of 
thumb is, any preference which deals with graphics detail or sound can be disabled and 
will cause the Sniffer Dog™ game to increase the speed at which it plays. The 
preferences are generally self-explanatory so this manual will not go into much detail on 
using the them with the exception of the three Macintosh general preference options. 
These three options, when used, have the affect of setting all of the other preferences to 
pre-defined values appropriate for the type of Macintosh you are running the software on.

If you are running Sniffer Dog™ on a 68030 or 68020 based Macintosh, choose Set Prefs 
Other Macintosh to obtain the maximum performance (refresh rate) from the Sniffer 
Dog™ game.
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If you are running Sniffer Dog™ on a 68040 or 68LC040 based Macintosh, choose Set 
Prefs 68040 Macintosh to obtain the maximum performance from the Sniffer Dog™ 
game running on a 68040 based Macintosh.
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If you are running Sniffer Dog™ on a Power Macintosh, choose Set Prefs Power 
Macintosh to obtain the maximum performance and detail from the Sniffer Dog™ game 
running on a Power Macintosh. Choosing the Power Macintosh preference option also 
changes the type of title presentation that is displayed at the beginning of the program.
Other preferences allow you to disable or enable the following:

Preference Effect

Title Presentation Allows you to bypass it
Screen Size 512 x 322 screen runs faster
Background Sound Disabling speeds up the game
Sound Effects Used for noise reduction in classroom
Auto slow down near trees Disabling speeds up the game
Auto speed up when objects Enabling speeds up the game

when objects are off the screen
Travel and Turning Speed Used to control movement speed
Mouse / Keyboard controls    Used to select input device type

Select the preferences which are most appropriate for your computer. If you want to set 
the preferences of Sniffer Dog™ on multiple computers the same way, copy the Sniffer 
Dog™ Prefs file located in your Preferences folder (which is inside your System Folder) 
to every computer you intend to run Sniffer Dog™ on after installing Sniffer Dog™ from 
the main installer disks. Please make sure each computer you copy the preferences file to 
can support the screen size you chose.

26



Troubleshooting

If you encounter any internal errors while playing Sniffer Dog™, you will be notified by 
a dialog box which displays Internal Error Code xx (where xx denotes the error code). If 
this situation occurs, contact Neptune Systems and we will try to resolve the problem as 
quickly as possible.

If any network based errors occur, check your network connection and make sure 
AppleTalk is turned on in the Chooser. If all else fails, restart your Macintosh and try 
again.

Any other errors which may occur may be a sign that memory is low. Try to increase the 
memory requirements of Sniffer Dog™ or the Teacher Utility to a higher limit if you 
have the memory to spare. If this fails to remedy the situation, please contact Neptune 
Systems and we will try to resolve the problem as quickly as possible.

NEPTUNE SYSTEMS
12819 Staton Drive
Austin, Texas 78727-3249
1-800-566-1247 
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